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Overview 

The Insurer’s Market Repository (hereafter referred to as IMR) is a web-based 
application offering users secure access to the IMR content via the internet. This 
document provides the information required to configure the web browser to enable 
them to use IMR. It also includes detailed instructions to validate the browser 
settings. 

The Getting Started section is intended to help first time users acquaint themselves 
with the expected actions depending on their browser configurations. 

A section on ‘Frequently Asked Questions’ points to information present elsewhere in 
the document, but in a question-answer format.  
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IMR Features that Require Configuration of Web Browser 

IMR is a web based application, which implies that it runs inside a web browser on 
the user’s computer. A variety of web browsers are available which support different 
standards. Incompatibilities even exist across different versions of the same browser. 
To allow for a comfortable and consistent user experience IMR recommends 
standard settings of the most commonly used browsers like Internet Explorer. 

Some of the features which can vary based on the user’s browser settings are 
described below. 

View Documents and Progress Bar 

If the browser is configured to the recommended settings, clicking on a document 
hyperlink (or using the View Link) opens the document in a new window using the 
application that the user has configured to open the file type i.e. Microsoft Word. A 
progress bar is also displayed indicating the progress of the download. 

Simultaneous Download of Multiple Documents 

If the browser is configured to the recommended settings, users can select multiple 
documents (by selecting on the adjacent checkboxes) and use the Download link 
(see figure 1).   

 

Figure 1 – IMR Screenshot of Multiple Documents Selected for Download 

The users can select more than one document for download and then click on the 
Download link. Once the Download link is clicked, the user is taken to another screen 
to specify the folder where the documents should be downloaded (see figure 2). 

 

Figure 2 – IMR Screenshot of Downloading Multiple Documents 
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Direct Load 

Direct Load is accessed via the Direct Load tab and then after entering the UMR on 
the UMR Entry screen, the user is able to upload documents via the Direct Load 
Document Load screen (see figure 3).  

 

Figure 3 – IMR Screenshot of Direct Load Document Load 

Add Document 

Documents can be added using the Add link for the folders on the UMR and UCR 
view. The Add Documents screen is displayed and it is possible to add multiple 
documents (see figure 4).  

 

Figure 4- IMR Screenshot of Add Documents for Multiple Documents 
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Role of Applets 

The features described above are made possible through the use of applets. Applets 
require that the web browser is configured with an appropriate Java Runtime 
Environment. All modern browsers support easy installation of the Java Runtime 
Environment and the use of applets. However, if the users decide not to use applets 
in the web browser, IMR can still be used albeit with some limitations. The impact of 
not using applets in the web browser is described in the next section. 
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Impact of Not Using Applets 

If the browser is not using the recommended settings and applets are disabled, the 
features specified in the previous section will not function as described above. 

View Documents 

If applets are not available in the web browser and the user clicks on the file 
hyperlink or clicks on the ‘View’ link, the user is prompted to save the file rather than 
the file being displayed (see figure 5). Once saved, the user can then view the file by 
opening it on their file system.  

 

Figure 5- IMR Screenshot of File Saving Prompt 

Simultaneous Download of Multiple Documents 

If applets are not available in the web browser, the users will not be able to download 
multiple files simultaneously.   

The users can still save one file at a time by clicking on the document hyperlink and 
using the View option available in the File menu of the browser. 

As can be seen in the screen capture below (figure 6), the Download link is not 
shown to the user.  

 

Figure 6 – IMR Screenshot of Missing Download Link 
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Direct Load 

Direct Load does NOT work without applets. After entering a UMR on the UMR Entry 
screen, the user will see a blank screen after selecting the Submit button (see figure 
7).  

 

Figure 7- IMR Screenshot of Direct Load Without Applets 

Add Document 

Only one document can be added at a time using the Add Document functionality 
from any of the folders on the UMR or UCR screens. As can be seen in the screen 
capture below (figure 8), only one document can be added at a time. This is different 
from the Add Document shown in the previous section where more than one 
document can be added at a time (see figure 4).  
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Figure 8 – IMR Screenshot of Add Document for Single Document 
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Web Client and Browser Requirements 

In order to use the IMR the following software is required on the user’s computer 

Operating System 

Microsoft Windows® 98, Windows 98 Second Edition, Windows Millennium Edition 
(Windows Me), Windows NT® 4.0 with the high encryption version of Service Pack 
6a (SP6a) and higher, Windows 2000, or Windows XP. 

Web Browsers 

Microsoft Internet Explorer 6.0 Service Pack 2 

OR 

Mozilla Firefox 1.0 for Microsoft Windows® 

Java Runtime Environment 

Microsoft JVM 

Microsoft JVM 5.0.3810 for the following configurations: 

• Internet Connection with no Proxy Server 

• Internet Connection with Proxy Server, but no Socket Permission/ 

• Internet Connection with Proxy Server and Socket Permission. 

Sun JVM 

The Java Runtime Environment is required for applets in the web browser. The 
details are available in the role of applets section. 

The table below shows the java versions, and configurations, that work for the IMR 
(Note: Java 1.6.x is not included).  

Sun Java 
Runtime 

Environment 
(JRE) 

Internet 
Connection with 
no Proxy Server 

Internet 
Connection with 
Proxy Server, but 

no Socket 
Permission 

Internet 
Connection with 
Proxy Server and 

Socket 
Permission 

1.4.2_06 9 X X 
1.4.2_07 9 X X 
1.4.2_08 9 X X 
1.4.2_09 9 X X 
1.4.2_10 9 X X 
1.4.2_11 9 X X 
1.4.2_12 9 X X 
1.4.2_13 9 9 9 
1.5.0 9 X X 
1.5.0_01 9 X X 
1.5.0_02 9 X X 
1.5.0_03 9 X X 
1.5.0_04 9 X X 
1.5.0_05 9 X X 
1.5.0_06 9 X X 
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1.5.0_07 9 X X 
1.5.0_08 9 X 9 
1.5.0_09 9 X 9 
1.5.0_10 9 X 9 
1.5.0_11 9 X 9 
 

A bug that causes timeout errors when downloading documents when using a proxy 
server was fixed in Sun Java JRE versions 1.4.2_13 and 1.5.0_8 onwards. 

If the applet functions do not work with the later versions of Java (1.5.0 and higher), 
this will require a change to client’s java policy file to add a socket permission (see 
below) to allow the applet to run correctly via the proxy server within your network 
configuration. 

Java 1.6.x does not appear in the table because it is not supported. If you are 
experiencing problems using this version, then we suggest you downgrade to a 
version listed in the table. When downgrading, it is vital that you first uninstall both 
Java 1.6.x AND the lower version you wish your Internet Explorer to use (if already 
installed) and then, re-install the lower version. This is because Internet Explorer 
uses the copy of java.exe silently made by the install into your C:\WINDOWS\System32 
folder, on which you have no control over, even if you explicitly say not to install the 
public JRE. 

Note: When using a Sun JVM then the window from where you select which 
documents to load from your file system will default to “My Documents” rather than 
your “Last Visited” location. 

Adding the Socket Permission for the Proxy Server 

The socket permission for the proxy server is added to the java system policy file, 
which is located in “{java.home}/lib/security/java.policy”. The following lines need to 
be added to this file within the brackets “{“ and “}”. After this change the computer will 
need to be restarted to take effect. 

// Grant allowing signed applets to connect via the proxy server over https 

Permission java.net.SocketPermission “PROXY-SERVER-HOST:PROXY-SERVER-PORT”, 
“connect, accept, resolve”; 

An example java.policy file with this line added is attached for a proxy server of 
10.1.10.1 and port number of 80. 

Policy.txt  
Conclusions 

• If you do use a proxy server, and are using Java 1.4.x, the only version that 
will work is 1.4.2_13. 

• If you are specifying a proxy server, and using Java 1.5.x, you need to use 
version 1.5.0_08 or higher, and you may need to add a socket permission. 
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Validating the Web Client and Browser Configuration Requirements 

 

IMR provides a simple way by which users can validate if their browser is setup with 
the recommended configuration. 

View the Current Browser Configuration 

In order to check the browser configuration, users need to navigate to the following 
URL: 

https://repository.xchanging.com/worksitemp/index.jsp  

Select “Validate Browser” option (see figure 9). 

 

 

Figure 9 – IMR Screenshot of Validate Browser Option 

If the browser is set up correctly, the user should see all tick marks. The following two 
screen captures show the browser configuration for Internet Explorer 6 (Service Pack 
2) running on Windows XP Professional Operating System, having Sun JRE 
1.4.2_13 and MS JVM respectively (see figures 10 and 11).  
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Figure 10 – Browser Settings for Sun JVM 1.4.2_13  

 

 

Figure 11 - Browser Settings for Microsoft JVM 5.0.3810 
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Figure 12 - Browser Settings when neither Sun nor Microsoft JVM Installed 
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Checking settings in Internet Explorer 6 

 

Once the required software is present on the user’s computer, it is recommended 
that the following settings are verified. 

Security Settings 

From the browser menu, choose Tools -> Internet Option -> Security -> Custom 
Level (see figure 13). . 

 

Figure 13 - Screenshot of Security tab 

Check for the options of “Scripting for Java applets”. It should be “enabled” as shown 
in the screen shot (see figure 14). 

 

Figure 14 - Screenshot of Scripting options 
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Configuration for Running Applets 

From the browser menu, choose Tools -> Internet Option -> Advanced 

Case 1 – If using the Sun JRE 

Please check the “Java (Sun)” option is selected (see figure 15). 

 

Figure 15 – Screenshot of Advanced Tab 
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Case 2 – If using the Microsoft JVM  

 

Figure 16 - Screenshot of Microsoft JVM Settings 
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Case 3 – If Sun JRE as well as Microsoft JVM is not used 

Please note that if neither Sun JRE nor Microsoft JVM is installed, user will 
not be able to use the features described in section ‘IMR Features which 
require configuration of Web Browser’.  

 

Resetting Preferences for Applets 

IMR records the preferences of ‘using applets’ or ‘not using applets’ in cookies1 on 
the user’s machine. In some cases, it is possible that after the version of Java is 
updated in the browser from a non compatible version to a compatible version, the 
preferences recorded in the cookie are not updated. In such cases, users should 
delete the cookie present on their machine. Users must also delete the ‘cookie’ if 
they want to change their preferences from ‘Not using Applets’ to ‘Using Applets’. 
Please follow the following steps to delete cookies for IMR in Internet Explorer 6. 
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1. In the Internet Explorer Window, please click on Tools – ‘Internet Options’. 

 

2. Next, click on the ‘Settings’ Button (see figure 17).  

 

Figure 17 - Screenshot of Settings Button 
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3. Next, click on the ‘View Files’ Button (see figure 18). This should open a window 
showing all the Temporary Internet Files (see figure 19). 

 

Figure 18 - Screenshot of "View Files" Button 

 

Figure 19 - Screenshot of worksitemp Temporary Files 

4. Please select all files by name worksitemp and delete them.  

5. Close the window showing Temporary Internet Files. Also, please close all the 
Internet Explorer Settings windows by clicking the ‘Ok’ button. 

To set the new preferences, please follow the steps in the next section. 
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Getting Started Guide 

This section describes the actions that users can take when they use the IMR 
Application for the first time. The three subsections describe the difference in 
experience depending on whether Sun JVM or Microsoft JVM is available or if neither 
JVM is available.  

Checking the browser for this information is simple and is described in the View the 
current browser configuration section. 

 

When Using Sun JVM versions 1.4.2_13 and 1.5.0_11 

Navigate to IMR URL: https://repository.xchanging.com/worksitemp/index.jsp  

Please enter the account ID, username and password and click on the “Login” button 
(see figure 20). 

 

 

Figure 20 - Screenshot of IMR Login 
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If the account ID, user name and password are correct, the following page should be 
displayed (see figure 21). 

 

Figure 21 – IMR Screenshot of Signed Applet Popup 

As can be seen in the screen capture above (see figure 37), the user is prompted if 
he/she would like to download the signed applet distributed by Interwoven, Inc.  

In order to use all of the features offered by the IMR you will need to click the “Yes” 
button. This is required to run applets in the web browser. The details are available in 
the Role of applets section. 

The users should confirm the use of the applet with their “in house” IT/Technical 
support.  

For signing certificate details, please see Annexure 2. 

If the users wish to run the applets and do not want to be asked again, they should 
click the “Always” button to download the security certificate relating to the applet. 

Should the users not wish to download the applet, they should click the “No” button. It 
is important to note that IMR Application can still be used if the users select the “No” 
option. Selecting “No” results in applets not being available. The features of IMR that 
are not available without applets are described in the ‘Impact of not using Applets’ 
section. 

 If “No” option is selected, a warning message is displayed (see figure 22). 
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Figure 22 – IMR Screenshot of Warning Message if Applets Not Enabled 

The users should select the OK button, upon which they are directed to the IMR 
home page. 
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When using Microsoft JVM 

Navigate to IMR URL: https://repository.xchanging.com/worksitemp/index.jsp  

Please enter the account ID, username and password and click on the “Login” button 
(see figure 23). 

 

Figure 23 - Screenshot of IMR Login 

If the user name and password are correct, the users should see a screen similar to 
the one below (see figure 24).  
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Figure 24 – IMR Screenshot of Interwoven Applet Software Popup 

As can be seen in the screen capture above (figure 40), the user is prompted if 
he/she would like to download the signed applet distributed by Interwoven, Inc.  

In order to use all of the features offered by the IMR the users will need to click the 
“Yes” button. This is required to run applets in the web browser. The details are 
available in the Role of applets section. 

The users should confirm the use of the applet with their “in house” IT/Technical 
support.  

For signing certificate details, please see Annexure 2. 

Please note that to choose the “Run” option, an internet connection to site other than 
https://mwl.xchanging.com is not required. 

If the users wish to run the applets and do not want to be asked again, they can click 
on “More options” and select “Always run software from Interwoven, Inc.” and press 
“Run” button. This is shown in the screen captures below (see figures 25 and 26).  
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Figure 25 - Screenshot of More Options button 

 

Figure 26 - Screenshot of Options 

Should the users not wish to download the applet, they should click the “Don’t Run” 
button. It is important to note that IMR Application can be used if the users select the 
“No” option. Selecting “No” results in applets not being available. The impact of not 
having applets is described in the ‘Impact of not using Applets’ section. 

If “No” option is selected, a warning message is displayed (see figure 27). The users 
should select the OK button, upon which they are directed to the IMR home page. 
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Figure 27 – IMR Screenshot of Warning Message if Applets Not Enabled 
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When No JVM installed or Applets are not available 

Applets may not be available for use by IMR website because of the following 
reasons: 

• A recommended version of Sun JRE or Microsoft JVM is not installed. 

• Sun JRE is installed but at the time of security warning prompt, user has 
selected “No” option. 

• Microsoft JVM is installed but at the time of security warning prompt, user has 
selected “Don’t run” option. 

 

This section describes the actions users can take when the applets are not available. 

 

The user navigates to IMR URL: 
https://repository.xchanging.com/worksitemp/index.jsp  

Enters the account ID, username and password and clicks on the “Login” button (see 
figure 28). 
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Figure 28 - Screenshot of IMR Login 

A warning message should be displayed saying that applets are not available (see 
figure 29). The users should click on the OK button to use IMR. 

It is important to note that IMR Application can be used without applets. The impact 
of not having applets is described in the ‘Impact of not using Applets’ section. 
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Figure 29 - IMR Screenshot of Warning Message if Applets Not Enabled 
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Frequently Asked Questions 

 

Does IMR work with Sun JRE 1.3 / JVM 1.3? 

IMR does not work with Sun JRE 1.3 / Sun JVM 1.3. It is recommended that users 
should upgrade to a recommended version of Sun JRE e.g. 1.4.2_13. More details 
are available in requirements for JRE section. 

 

Does IMR work with Sun JRE 1.5 or Java 5? 

Yes, IMR works with JRE version 1.5.0_11.  However, since the support for Java 5 
commenced in February 2007, it is possible that users with Java 1.5 in the browsers 
prior to this might not be able to use applets. This should be resolved by resetting the 
preferences for applets as described in the section ‘Resetting Preferences for 
Applets’ 

 A special setting is required when JRE version 1.5.0_11 is used and MWL or IMR is 
accessed using proxy server. This setting is described in Annexure 3.  

 

Does IMR work with Internet Explorer 7? 

No problems have been found with IMR running on Internet Explorer 7. However, 
Internet Explorer 7 is not supported by IMR and it is recommended that Internet 
Explorer 6 with Service Pack 2 is used.  
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How do I check which JVM version do I have OR if I have applets enabled or 
not? 

This can be checked by visiting the following URL in your browser.  

https://mwl.xchanging.com/worksitemp/bc/browserinformation.jsp

More details are available in the View the current browser configuration section. 

 

What is an applet? 

An applet is a program written in the Java programming language that can be 
included in an HTML page. For more details Please refer to the Glossary section. 

 

What should I do when JRE 1.5 is installed in my machine but I want to use 
JRE 1.4.2_13? 

Uninstall JRE 1.5 through windows control panel -> Add or Remove Programs, once 
it is completed install JRE 1.4.2_13 and restart the machine. To allow MWL or IMR to 
recognize JRE 1.4.2_13 in your browser, please follow the steps outlined in the 
section ‘Resetting Preferences for Applets’ 

 

From where can I download the Sun JRE version supported by IMR? 

You can download the Sun JRE from Sun’s web-site, following are the URLs 

1. Sun JRE 1.4.2_13: http://java.sun.com/j2se/1.4.2/download.html 

2. Sun JRE 1.5.0_11: http://java.sun.com/javase/downloads/index_jdk5.jsp 

The above two are the latest version of Sun JRE, once the newer version of JRE is 
available you can download 1.4.2_13 and 1.5.0_11 versions from 
http://java.sun.com/products/archive/ URL. 
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Support 

Should you encounter any issues accessing the IMR or have any questions, please 
contact Service Desk using the following contact details: 

Email: servicedesk@xchanging.com

Helpline: +44 (0) 870 380 0830 
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Annexure 1: Glossary of Terms 

 

Applet: An applet is a program written in the Java programming language that can 
be included in an HTML page, much in the same way an image is included in a page. 
When you use a Java technology-enabled browser to view a page that contains an 
applet, the applet's code is transferred to your system and executed by the browser's 
Java Virtual Machine (JVM).  

For more details, please refer http://java.sun.com/applets/

JRE: JRE stands for Java Runtime Environment: This is the package of software that 
must be installed on a machine in order to run Java applications. 

JVM: JVM stands for Java Virtual Machine. A JVM is a piece of software that is 
responsible for running Java programs 

Cookie: HTTP cookies, sometimes known as web cookies or just cookies, are 
parcels of text sent by a server to a web browser and then sent back unchanged by 
the browser each time it accesses that server. HTTP cookies are used for 
authenticating, tracking, and maintaining specific information about users, such as 
site preferences. 
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Annexure 2 

 

Sun JRE version 1.5.0_11 is used and IMR is accessed using proxy server 

A special setting is required in the user’s local machine if Sun JRE version 1.5.0_11 
is used with proxy server to access https://mwl.xchanging.com or 
https://repository.xchanging.com/worksitemp/index.jsp. 

Please perform the following steps to make the required change in the user’s 
machine. 

1. Open the file “java.policy” available in “C:\Program 
Files\Java\j2re1.5.0_11\lib\security” directory. 

2. Add the following line at the end of the file. 

o grant {  

permission java.net.SocketPermission "PROXY HOST:PROXY 
PORT", "connect,accept,resolve";  

      }; 

o Please replace the highlighted text with the actual proxy server host 
address and port number and save it. 

3. Close any existing browser sessions and access IMR in a new browser 
session. 
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